A Simple and Effective Method for Quantifying Leaf Variegation

Qiansheng Li1,6, Jianjun Chen1,3,7, Dennis B. McConnell2,4, and Richard J. Henny1,5

Additional index words. foliar variegation, foliage plants, ornamental plants, quantification of leaf variegation (QLV)

Summary. A simple and effective method for quantification of leaf variegation was developed. Using a digital camera or a scanner, the image of a variegated leaf was imported into a computer and saved to a file. Total pixels of the entire leaf area and total pixels of each color within the leaf were determined using an Adobe Photoshop graphics editor. Thus, the percentage of each color’s total pixel count in relation to the total pixel count of the entire leaf was obtained. Total leaf area was measured through a leaf area meter; the exact area of this color was calculated in reference to the pixel percentage obtained from Photoshop. Using this method, variegated leaves of ‘Mary Ann’ aglaonema (Aglaonema), ‘Ornate’ calathea (Calathea ornata), ‘Yellow Petra’ codiaeum (Codiaeum variegatum), ‘Florida Beauty’ dracaena (Dracaena sanderiana), ‘Camille’ dieffenbachia (Dieffenbachia maculata), and ‘Triostar’ stromanthe (Stromanthe sanguinea) were quantified. After a brief training period, this method was used by five randomly selected individuals to quantify the variegation of the same set of leaves. The results were highly reproducible no matter who performed the quantification. This method, which the authors have chosen to call the quantification of leaf variegation (QLV) method, can be used for monitoring changes in colors and variegation patterns incited by abiotic and biotic stresses as well as quantifying differences in variegation patterns of plants developed in breeding programs.

Variegation is referred to as the presence of discrete markings of various colors on an organ or an organism (Marcotrigiano, 1997). Markings may be stripes, blotches, or streaks of white, cream, yellow, or other colors. Variegation in plants is categorized as either cell lineage or noncell lineage types (Kirk and Tilney-Bassett, 1978). Cell lineage variegation generally occurs in genetic mosaics (i.e., individuals with cells of different genotypes), whereas in noncell lineage variegation all cells have the same genotype but the genes responsible for the synthesis or destruction of pigments are expressed only in some of the cells (Marcotrigiano, 1997). Cell lineage variegation is usually expressed in monocots by striped or striated patterns. The most common cell lineage variegation patterns are formed by periclinal chimeras in which cell layers with different genotypes develop next to each other (Tilney-Bassett, 1986). Noncell lineage variegation occurs in many genera, and variegated patterns can be inherited in simple Mendelian fashion, such as in aglaonema (Henny, 1983) and dieffenbachia (Henny, 1982).

Variegation is an important trait to ornamental plants. More than one-third of commercially produced ornamental foliage plants are valued for their foliar variegation (Chen et al., 2004), and consumers’ preferences for plant characteristics placed foliar variegation as the second most important consideration in the purchase decision. In landscape design, variegated plants are often used as the center of attention or as a focal point in gardens.

The ecological and evolutionary significance of foliar variegation has not been well studied (Lev-Yadun et al., 2002). Proposed adaptive value includes the protection of plants against abiotic factors such as ultraviolet irradiation (Hoch et al., 2001), low temperature (Oren-Shamir and Levi-Nissim, 1997), and oxygen toxicity (Yamasaki, 1997), and against biotic factors such as fungal attack (Coley and Aide 1989) and herbivory (Cahn and Harper, 1976; Givnish, 1990). Nevertheless, environmental factors, particularly light intensity, have been shown to affect substantially the amount and degree of variegation of many ornamental foliage plants (Tilney-Bassett, 1986). Shen and Seeley (1983) reported that variegation was increased in ‘Albo Margina’ and ‘Variegata’ peperomia (Peperomia obtusifolia) as light levels were reduced from 20% to 73% shading during the production. Similarly, a study of shade on ‘Ribbon’ ribbon dracaena (Dracaena sandieriana) variegation by Vladimirova et al. (1997) showed that leaf variegation increased as production light exclusion increased from 47% to 91%. Conversely, Bequette et al. (1985) found that the degree of variegation in ‘Bravo’ and ‘Norma’ codiaeum (Codiaeum variegatum) decreased as production light intensities decreased from 950 µmol·m–2·s–1 to 350 µmol·m–2·s–1. Leaf variegation also changes when foliage plants are transferred from production environments to indoor conditions for interiorscaping (Chen et al., 2005b). Undesired changes in foliar variegation often result in significant loss of ornamental value (Henny and Chen, 2003; Marcotrigiano and Gradziel, 1997). Thus, selection of appropriate light levels in shaded greenhouses and building interiors is critical to producing and maintaining variegated foliage plants with the greatest aesthetic appeal (Chen et al., 2005a). However, only limited research has been conducted to evaluate the interaction between environmental and physiological

<table>
<thead>
<tr>
<th>Units</th>
<th>To convert U.S. to SI, multiply by</th>
<th>U.S. unit</th>
<th>SI unit</th>
<th>To convert SI to U.S., multiply by</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5400 inch(es)</td>
<td>cm</td>
<td>1</td>
<td>1</td>
<td>0.3937</td>
</tr>
<tr>
<td>6.4516 inch2</td>
<td>cm2</td>
<td>1</td>
<td>1</td>
<td>0.1550</td>
</tr>
</tbody>
</table>
factors that influence leaf variegation patterns.

Regardless of basic or applied research on foliar variegation, a technique that can simply quantify the amount of variegated color on leaves is required. Highly technical optical apparatuses, such as a digital image analyzer, have been used effectively (Smith et al., 1988), but they are expensive and inconvenient. More recently, a technique using a photography machine to quantify leaf variegation was developed (Marcotrigiano and Hackett, 1993). With this method, leaves taped to a white paper were photocopied by varying the contrast setting until the lighter regions of the leaf did not show an image on the paper. From this image sheet, a transparency was produced and then passed through a leaf area meter for determining the area imprinted on it without dissecting out the image. This method, however, is tedious and difficult because several rounds of copying and adjusting the contrast settings of the photocopy machine are needed. Additionally, it does not precisely distinguish between colors, because the image is in black and white.

With the availability of digital cameras, scanners, and computer software, photographic images can be easily processed into digital form. Digital images are useful for color analysis because they are easy to record and process with little distortion. Quantification of variegated leaves through digital images was mentioned in recent publications (Chen et al., 2004, 2005b; Pennisi et al., 2005), but detailed information was not given in either of the reports. The objective of this study was to develop a simple and effective method of quantification of leaf variegation (QLV) using digital cameras or scanners for image acquisition and using Adobe Photoshop v.3.0 (Adobe Systems, San Jose, Calif.) for quantifying variegation.

Materials and methods

Plant materials. ‘Florida Beauty’ dracaena (a plant with cell lineage variegation pattern); ‘Mary Ann’ aglaonema, ‘Ornata’ calathea, ‘Yellow Petra’ codiaeum, and ‘Camille’ dieffenbachia (plants with noncell lineage variegation pattern); and ‘Ornata’ celothel and ‘Triostar’ stromanthe (plants with unknown lineage variegation pattern) were grown in shaded greenhouses under a maximum photosynthetically photon flux of 400 μmol·m⁻²·s⁻¹. The most recently matured leaves (the third leaf from the shoot meristem) were used in this study.

Image acquisition instruments. Instruments used in this study included a ScanJet IICX (Hewlett-Packard, Palo Alto, Calif.), a Nikon digital camera Coolpix 5000 (Nikon Co., Tokyo), an LI-3100 area meter (LI-COR, Inc., Lincoln, Nebr.), and a desktop computer installed with Adobe Photoshop Elements (version 3.0 for Windows).

Image acquisition. The file format of the Nikon digital camera was set as JPEG (joint photographic experts group). A clean black cloth was placed behind a leaf of interest and an image was taken using the digital camera. The same leaf was cut from the plant, placed on the ScanJet IICX, and scanned with a resolution for color images of 72 dots per inch (dpi) or higher. The scanned image was saved and converted to a JPEG format. Image files acquired from both the digital camera and scanner were loaded into a computer.

Variegation percentage quantification. Individual leaf images were opened through Photoshop. The magic wand tool was selected from the Tool Box menu, and its tolerance was set at 32. While pressing the shift key, the empty space outside the leaf surface was selected using the magic wand tool. Under the Select menu, “Inverse” was selected and used to convert the selection from the background to the whole leaf area only. In this case, the whole margin of the leaf was surrounded by a dashed line. “Histogram” was selected from Window menu (some other versions of this software may place “Histogram” under the Image menu), and a message box appeared in which the total pixel count of the leaf surface area was provided. This pixel value was recorded and considered as X. After closing the message box, one variegated area was selected using the magic wand tool. Under the Select menu, “Similar” was selected, and all areas having the same color as the one selected were highlighted by dashed lines. If some areas were not selected, “Grow” could be used under the Select menu to include the remaining spots. If unwanted colors were selected using the similar or grow steps, the tolerance number set at 32 could be reduced to eliminate unwanted color. After completing the selection, “Histogram” was then selected to obtain the total pixels of the selected area. This pixel value was recorded and considered as Y. The percentage of variegated area in relation to the entire leaf area based on pixels was obtained by dividing X by Y values.

Quantification of variegated area. After quantifying the percentage of variegated area based on the pixel count of each color, the leaf was run through an LI-3100 area meter. Total leaf area based on metric value (measured in square centimeters) was obtained. The exact area of a color was then calculated based on the percentage of the color measured using pixels through the Photoshop program. To test the reproducibility of this method, a group of individuals was trained, and five individuals were randomly selected. The same variegated leaves shown in Fig. 1 were quantified by these five individuals independently. Means and corresponding ses for total pixels of the entire leaf area, total pixels of variegated area within the leaf, and percentage of variegated area obtained by the five individuals were calculated.

Results and discussion

Leaves of ‘Mary Ann’ aglaonema, ‘Ornata’ calathea, ‘Yellow Petra’ codiaeum, ‘Florida Beauty’ dracaena, ‘Camille’ dieffenbachia, and ‘Triostar’ stromanthe showed different patterns of variegation (Fig. 1). Pixel percentages of the nongreen or variegated areas (light green, white, yellow, and light pink, depending on the plant) generated by Photoshop from images taken by the digital camera and scanned by the ScanJet are presented in Table 1. There were small differences in the pixel percentages generated by the digital camera and scanner, but the differences were not statistically significant. The differences might be caused solely by the digital camera, because images were taken in the shaded greenhouses, where light intensity and direction could affect the degree of variegated
color. The scanner, however, with no change in light intensity and direction, should have produced more consistent and more accurate images. Thus, the use of a digital camera to acquire images is only recommended under conditions when leaves of interest are not abscised; otherwise, a scanner should be used for image acquisition. Additionally, the $\text{SE}$ for the total pixels of the nongreen area were higher than those for the total pixels of the entire leaf area (Table 1). This may be attributed to differences among trained individuals in determining the area of variegated color. However, the $\text{SE}$ in contrast to the corresponding means are quite low, suggesting that human bias is low and the QLV method is highly reproducible.

Fig. 1. Digital images of variegated leaves from ‘Mary Ann’ aglaonema (A), ‘Ornata’ calathea (B), ‘Yellow Petra’ codiaeum (C), ’Camille’ dieffenbachia (D), ‘Florida Beauty’ dracaena (E), and ‘Triostar’ stromanthe (F). Actual leaf sizes of dracaena and stromanthe were smaller than those presented in the photos (see Table 2 for their surface areas).

The exact area of a color was also obtained if the actual leaf area was known (Table 2). This information is important for monitoring changes in a stripe, blotch, or streak size over time. For example, pastel-white blotches of ‘Camille’ dieffenbachia leaves that were produced under a production light level of 400 μmol·m$^{-2}$·s$^{-1}$ gradually turned light green and eventually dark green after placement indoors under a light level of 16 μmol·m$^{-2}$·s$^{-1}$ (Chen et al., 2005b). With the availability of this QLV method, time course change in blotch size and color can be monitored over time under different interior light levels, and appropriate light levels for maintaining the variegation patterns of this cultivar can be determined. This method can also be used for studying the adaptive values of coloration to other abiotic and biotic factors as suggested by Lev-Yadun et al. (2002).

The QLV technique shows clear advantages with regard to objective, reliable, and convenient analysis of foliar variegation. Digital color images hold complex information, and each pixel of an image is composed of position and color information usually expressed in red, green, and blue on a screen monitor. During the quantification process, colors were selected through the Photoshop program, and the pixel percentage of each color was calculated automatically through the program. These procedures reduce human bias in color determination and yield rather consistent results. Thus, the QLV method provides sufficient reproducibility of the results (Table 1). Furthermore, this method was developed from readily available components and does not require any additional software or instruments. Data can be generated in a regular laboratory or an office in a short period of time.

In addition to being used for studying foliar variegation that may be incited by abiotic and biotic factors, this method can also be used for identification and selection of somaclonal variants regenerated from micropropagation, mutants from vegetative propagation, and new cultivars derived from sexual hybridization. For example, many new cultivars of ornamental foliage plants differ in foliar variegation. The variegation patterns of those new cultivars were only described but have never been quantitatively documented (Henny et al., 2003, 2004, 2006). This method provides a useful tool for quantification of foliar variegation in

Table 1. Mean total pixels of entire and variegated (nongreen) leaf areas as well as percentage of leaf variegation based on pixel readings using Adobe Photoshop Elements (version 3.0; Adobe Systems, San Jose, Calif.) in ‘Mary Ann’ aglaonema, ‘Ornata’ calathea, ‘Yellow Petra’ codiaeum, ’Camille’ dieffenbachia, ‘Florida Beauty’ dracaena, and ‘Triostar’ stromanthe.

<table>
<thead>
<tr>
<th>Plant</th>
<th>Total pixels (n)</th>
<th>Nongreen pixels (n)</th>
<th>Variegation (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Scanner</td>
<td>Camera</td>
<td>Scanner</td>
</tr>
<tr>
<td>Aglaonema</td>
<td>85735 ± 3$^*$</td>
<td>86617 ± 45</td>
<td>29587 ± 506</td>
</tr>
<tr>
<td>Calathea</td>
<td>98674 ± 1</td>
<td>99703 ± 46</td>
<td>42920 ± 222</td>
</tr>
<tr>
<td>Codiaeum</td>
<td>94045 ± 0</td>
<td>94112 ± 0</td>
<td>47007 ± 126</td>
</tr>
<tr>
<td>Dieffenbachia</td>
<td>84998 ± 9</td>
<td>84799 ± 1</td>
<td>47590 ± 356</td>
</tr>
<tr>
<td>Dracaena</td>
<td>41187 ± 0</td>
<td>40023 ± 0</td>
<td>21988 ± 196</td>
</tr>
<tr>
<td>Stromanthe</td>
<td>45240 ± 1</td>
<td>45617 ± 2</td>
<td>18055 ± 631</td>
</tr>
</tbody>
</table>

$^*$Mean ± SE (n = 5).
breeding of ornamental foliage and other plants.

**Literature cited**


